DEAR JENSEN® CUSTOMER

Selecting fine audio equipment such as the unit you've just purchased is only the start of your
musical enjoyment. Now it's time to consider how you can maximize the fun and excitement
your equipment offers. This manufacturer and the Electronic Industries Association's
Consumer Electronics Group want you to get the most out of your equipment by playing it at a
safe level. One that lets the sound come through loud and clear without annoying blaring or

@NS@
distortion and, most importantly, without affecting your sensitive hearing.

Sound can be deceiving. Over time your hearing "comfort level" adapts to higher volumes of

3-SPEED STE REO TU RNTABLE WITH sound. So what sounds "normal" can actually be loud and harmful to your hearing. Guard
against this by setting your equipment at a safe level BEFORE your hearing adapts.

BUILT-IN SPEAKERS AND
To establish a safe level:
SPEE D ADJ USTM ENT e Start your volume control at a low setting.
e Slowly increase the sound until you can hear it comfortably and clearly, and without
distortion.

Once you have established a comfortable sound level:

e Set the dial and leave it there.

Taking a minute to do this now will help to prevent hearing damage or loss in the future. After
all, we want you listening for a lifetime.

We Want You Listening For a Lifetime

Used wisely, your new sound equipment will provide a lifetime of fun and enjoyment. Since
hearing damage from loud noise is often undetectable until it is too late, this manufacturer and
the Electronic Industries Association's Consumer Electronics Group recommend you avoid
prolonged exposure to excessive noise.

Customer's Record:

The serial number of this product is found on its back cover. You should note the serial
number of this unit in the space provided as a permanent record of your purchase to aid in
identification in the event of theft of loss.

USER MANUAL

Model Number: JTA-230 Serial Number:

JTA-230

PLEASE READ THIS USER MANUAL COMPLETELY BEFORE OPERATING THIS UNIT
AND RETAIN THIS BOOKLET FOR FUTURE REFERENCE.




TO PREVENT FIRE OR SHOCK HAZARD, DO NOT USE THIS PLUG WITH AN EXTENSION
CORD, RECEPTACLE OR OTHER OUTLET UNLESS THE BLADES CAN BE FULLY
INSERTED TO PREVENT BLADE EXPOSURE. TO PREVENT FIRE OR SHOCK HAZARD, DO
NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.

10.

11.
12.

CAUTION

RISK OF ELECTRIC SHOCK

DO NOT OPEN

The lightning flash with arrowhead
symbol, within an equilateral
triangel is intended to alert the user
to the presence of uninsulated
dangerous voltage within the
product is endosure that may be of
sufficient magnitude to constitute a
risk of electric shock to persons.

CAUTION: TO REDUCE THE RISK OF
ELECTRIC SHOCK, DO NOT REMOVE
COVER (OR BACK). NO USER - SERVICE-
ABLE PARTS INSIDE. REFERSERVICING TO
QUALIFIED SERVICE PERSONEL.

The exclamation point within an
equilateral triangel is intended to
alert the user to the presence of
important operating and mainte-
nance (servicing) instructions in the
literature accomoanying the
appliance.

IMPORTANT SAFETY INSTRUCTIONS

Read these instructions - All the safety and operating instructions should be read before the
appliance is operated

Keep these instructions - The safety and operating instructions should be kept for future
reference.

Heed all warnings - All warnings on the appliance and in the operating instructions should
be adhered to.

Follow all instructions - All operation and use instructions should be followed.

Do not use this apparatus near water - The appliance should not be used near water; for
example, near a bathtub, washbowl, kitchen sink, laundry tub, in a wet basement, or near a
swimming pool, and the like.

. Clean only with dry cloth - The appliance should be cleaned only as recommended by the

manufacturer.
Do not block any ventilation openings. Install in accordance with the manufacturer’s
instructions. - The appliance should be situated so that its location or position does not
interfere with its proper ventilation. For example, the appliance should not be situated on a
bed, sofa, rug, or similar surface that may block the ventilation openings; or placed in a
built-in installation, such as a bookcase or cabinet that may impede the flow of air through
the ventilation openings.

Do not install near any heat sources such as radiators, heat registers, stoves or other
apparatus (including amplifiers) that produce heat.

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug
has two blades with one wider than the other. A grounding type has two blades and a third
grounding prong. The wide blade or the third prong are provided for your safety. If the
provided plug does not fit into your outlet, consult an electrician for replacement of the
obsolete outlet.

Protect the power cord from being walked on or pinched particularly at ;?:12“;232?:&2??;
plugs, convenience receptacles, and the point where they exit from the
apparatus.

Only use attachments / accessories specified by the manufacturer

Use only with the cart, stand, tripod, bracket, or table specified by the
manufacturer, or sold with the apparatus. When a cart is used, use
caution when moving the cart/apparatus combination to avoid injury

N
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from tip-over.

Unplug this apparatus during lightning storms or when unused for a long periods of time.
Power Sources - The appliance should be connected to a power supply only of the type
described in the operating instructions or as marked on the appliance. Do not overload wall
outlet.

Wall and Ceiling Mounting - The appliance should be mounted to a wall or ceiling only as
recommended by the manufacturer.

. Power Lines - An outdoor antenna should be located away from power lines.

. Object and Liquid Entry - Care should be taken so that objects do not fall and liquids are not
spilled into the enclosure through openings.

The apparatus shall not be exposed to dripping or splashing and that no objects filled with
liquids, such as vases, shall be placed on apparatus.

Refer all servicing to qualified service personnel. Servicing is required when the apparatus
has been damaged in any way, such as power-supply cord or plug is damaged, liquid has
been spilled or objects have fallen into the apparatus, the apparatus has been exposed to
rain or moisture, does not operate normally, or has been dropped.

Servicing - The user should not attempt to service the appliance beyond that
described in the operating instructions. All other servicing should be referred to
qualified service personnel.

The MAINS plug or an appliance coupler is used as the disconnect device, the
disconnect device shall remain readily operable.

. Caution marking and nameplate are located on back of product.

CAUTION
TO PREVENT ELECTRIC SHOCK, MATCH WIDE BLADE OF PLUG TO WIDE SLOT. FULLY INSERT
THE PLUG TO MAIN POWER SOCKET.

AC Outlet

N\

AC Plug

PRECAUTION FORE USE

UNPACK ALL PARTS AND REMOVE PROTECTIVE MATERIAL.

DO NOT CONNECT THE UNIT TO THE MAINS BEFORE CHECKING THE MAINS
VOLTAGE AND ALL OTHER CONNECTIONS HAVE BEEN MADE.

DO NOT COVER ANY VENTS AND MAKE SURE THAT THERE IS A SPACE OF
SEVERAL CENTIMETERS AROUND THE UNIT FOR VENTILATION.




IMPORTANT NOTES
Avoid installing the unit in locations described below:

e Places exposed to direct sunlight or close to heat radiating appliances such as
electric heaters.

¢ Places subject to constant vibration.

e Dusty, humid or moist places.

COMPLIANCE WITH FCC REGULATIONS

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions:

(1) this device may not cause harmful interference, and

(2) this device must accept any interference received, including interference that may cause

undesired operation.

NOTE : This equipment has been tested and found to comply with the limits for a Class B digital

device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable

protection against harmful interference in a residential installation. This equipment generates,

uses and can radiate radio frequency energy and, if not installed and used in accordance with

the instructions, may cause harmful interference to radio communications. However, there is no

guarantee that interference will not occur in a particular installation. If this equipment does cause

harmful interference to radio or television reception, which can be determined by turning the

equipment off and on, the user is encouraged to try to correct the interference by one or more of

the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

- Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications not expressly approved by the party
responsible for compliance could void the user’s authority to operate
the equipment.

PROTECT YOUR FURNITURE

This model is equipped with non-skid rubber 'feet' to prevent the product from moving
when you operate the controls. These 'feet' are made from non-migrating rubber material
specially formulated to avoid leaving any marks or stains on your furniture. However
certain types of oil based furniture polishes, wood preservatives, or cleaning sprays may
cause the rubber 'feet' to soften, and leave marks or a rubber residue on the furniture. To
prevent any damage to your furniture we strongly recommend that you purchase small
self-adhesive felt pads, available at hardware stores and home improvement centers
everywhere, and apply these pads to the bottom of the rubber 'feet' before you place the
product on fine wooden furniture.

ACCESSORIES INCLUDED

- Application CD
- USB cable
- User Manual

GETTING STARTED
CONNECTING THE AC POWER CORD
1. Unwind the AC power cord fully and connect it to any convenient household 120V~ 60Hz AC
outlet
2. Turn on the power and the Power LED indicator will light. Your system is now ready to
play your music.

CONNECTING THE USB CABLE

1. To encode music from your records or from the Aux-in line, connect the USB Port of
the Turntable to a suitable USB port on your computer via the USB cable provided.

2. Please refer to CONNECTING TO A COMPUTER FOR RECORDING section of this
manual for detail.

LOCATION OF CONTROLS

1. Dust Cover

2. Left Speaker m

3. Pitch Adjust Control e

4. 3.5mm Headphone Jack ZE—%

5. Power LED Indicator

6. Power On/Off Switch

7. Auto Stop Switch

8. Right Speaker . N

9. Volume Control Knob R T = 10

10. Tone Control Knob
11. 45 RPM Record Adaptor

12. 33/45/78RPM Speed Selector . L
13. Tone Arm Rest/Holder 11
14. Line-Out RCA Jacks (L/R)
15. AUX-IN jack —~12
16. AC Power Cord
17. USB Port For Computer Connection 13
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CAUTION:
This unit should not be adjusted or repaired by anyone except qualified service
personnel.




STEREO PHONOGRAPH OPERATION
Please Note - Before Use

- Remove the stylus protector.
- Make sure that the tone arm is unlocked and free )
Cartridge
4

to move from the tone arm rest prior to operating.
Lock the tone arm in place again when not in use.
Stylus assembly —» &7
1. Slide the Power On/Off switch to the On position
2. Raise the turntable dust cover.
3. Place a record on the turntable platter (use the 45 RPM record adaptor if you are
playing 45 RPM records).
4. Set the speed selector to the proper position for the record you are playing.
5. Lift the tone arm from the rest and slowly move it over the
record. The turntable platter will begin spinning.
6. Place the tone arm down onto the record at the location that
you want to play.
7. Adjust the volume to the desired level.
8. Atthe end of record, the platter will automatically stop spinning. 4
Lift the tone arm from the record and return it to the rest.
9. To stop playing manually, lift the tone arm from the record and return it to the rest.

NOTES:

1. Certain types of records may have an auto-stop area outside the preset limit, so
the turntable may stop before the last track finishes. If this occurs, set the
AUTO-STOP switch to the “OFF” position. This allows the record to play to the
end, but please note that it will not stop automatically. You must manually raise
the tone arm and place it back in the rest and then turn off the power to stop the
turntable from spinning.

2. The turntable will automatically disconnect and stop playing when a 3.5mm
stereo aux-in cord (not included) is plugged into the Aux-in Jack on the back.
The turntable cannot be used while using the Aux-in, so be sure to disconnect
the Aux-in cord prior to using the turntable.

TONE CONTROL

Rotate the TONE control knob to adjust the treble level of the music you are playing.

PITCH CONTROL

The Pitch Control allows you to fine tune the playing speed of the record once the correct
speed (33/45/78 RPM) is chosen. Slide the Pitch Adjust Control to slightly increase or
decrease the speed of the turntable if necessary.

AUXILIARY INPUT

This unit provides an auxiliary audio signal input jack for connecting external audio
devices like MP3 players, CD players and older, non-dockable iPods (except iPod
shuffle 3 gen) so you can listen to your external source through the speakers of this

system.

1. Use an audio cable (not included) with one 3.5 mm stereo plug on each end of the
cable.

2. Plug one end into the AUX-IN jack on the main unit and the other end of the cable
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into the Line-out Jack or Headphone Jack of your external audio device. It will
automatically switch the unit to AUX mode.

3. Turn on unit power and your external audio device.

4. The volume level can now be controlled through the main unit. Operate all other
functions on the auxiliary device as usual.

Note:

(1). If the Line Out Jack of your external device is connected, then you only need to
adjust the volume control of this system. If the Headphone Jack of your external
device is connected, then you may need to adjust both the volume control of your
external device and the volume control of this system to find the most desirable
volume setting.

(2). The turntable cannot be used while using the Aux-in cord is plugged in, so be sure to
disconnect the Aux-in cord prior to using the turntable.

(3). Slide the POWER ON/OFF switch to turn off the system when you finish listening.

Don't forget to switch off the power on your external device as well.

LINE OUT CONNECTION

You can connect this unit to an external Hi-Fi / AMPLIFIER system by connecting the
LINE OUT RCA Jacks to the auxiliary input jacks on your Hi-Fi / AMPLIFIER system with
RCA cables (not included).

Note: The Volume control on the main unit will not adjust the volume when using the
LINE OUT.

USING HEADPHONES(NOT INCLUDED

Inserting the plug of your headphones into the Headphone jack will enable you to listen
in private.

READ THIS IMPORTANT INFORMATION BEFORE USING YOUR HEADPHONES

1. Avoid extended play at very high volume as it may impair your hearing.

2. If you experience ringing in your ears, reduce the volume or shut off your unit.

3. Keep the volume at a reasonable level even if your headset is an open-air type designed to

allow you to hear outside sounds. Please note that excessively high volume may still block
outside sounds.

CONNECTING TO A COMPUTER FOR RECORDING

Before getting start, please install the “AUDACITY ” recording software to your computer.
Below is an example using a computer with Microsoft XP and the Audacity software
installed. For other Windows OS or Mac OS, please visit Audacity website for details.

http://audacity.sourceforge.net/

INSTALLING THE AUDACITY SOFTWARE

1. Insert the Audacity disc (included) into the CD drive of your computer.

2. Click on My computer on the desktop.

3. Double click CD drive to view the contents of the CD and select “Windows” under
“Audacity” folder.

4. Open “Windows” folder and select “Audacity 2.0 (Windows 2000, XP, Vista, 7)”.

5. Open the folder and then double click Audacity set up icon with file name
“audacity-win-2[1].0.exe)” to install the Audacity software according to the
instruction, read license agreements of Audacity before installation.

NOTE:
Free software (AUDACITY) licensed under the GNU general public license (GPL).
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More information as well as open source code can be found on the provided CD or on 4. In the Sound Recording field, click the pull down menu to select “USB Audio
the website at: http://audacity.sourceforge.net/

Controller” as Default device of sound recording.

INSTALL THE USB DRIVE

Audio Properties

1. Use the included USB cable to connect the turntable to your computer. (ks Dovies |
2. Your computer will detect the JTA-230 as a “USB Audio Controller” & start to install Sound playback
USB drivers for it automatically. 2 ﬁ;:dwa 3
3. Wiaiting for the installation complete until your computer shows a pop up a message
that it is installed properly and ready to use. ST

ﬁ Defaul device:

SET RECORDING INPUT LEVEL (USE WINDOWS XP COMPUTER)

1. Click the “Start” in the left corner of your computer MID! muic playback
2. Select “All Programs” = “Accessories” = “Entertainment‘=» “Sound Recorder” to g Defaul device
4 S [ Miciosoll G5 Wavetable 5W Syrih v
open the sound record interface.

[ Use anly default devices

—

[ ot J[ coee J[ &emb |

] New Office Document

@ Open Office Document

@ Set Program Access and Defaults

% Windows Catelog
R windows Updete

5. Click the Volume button under the Sound recording tab to open "Recording

& 7 y
poyve—— Control* interface;
O e e 6. Adjust the line in volume to a level without distortion. You can play a record on the
(@ EPSOM Printers D Address Bock . . .
YT t—— | & ceser turntable and use the Sound Recorder to record a short clip of music for testing. The
) Fiezila FTF clisnt »l| @ command prompt . . .
@ cones | B e sound wave will show on the interface screen when recording.
{7 1€ Groupware Client 'Y Pant

) ) munes | @ program compatbiry wizard

@) it CodecPack » | Gas Remote Desttop Comnection Audio Properties
) KONICA MINOATA il 59 scanner and Camera izard = L L

[ Microsoft: Office Tools I € synchronize e Options HB|D

=l g ero , g F— Soihpley ek —

QuickTime » Windows Explorer e .

Administrator |[EEICTS | . wndows v ter Celer S Microphone
@ 5w N s | Chedia wave Devies v

g, Internet () symantec Endpoint Protection » Balance:

Tnternet Explorer Adobe Acrobat Distler X
@ ST'L . Adobe Acrobat X Pro Sound recording
e sy Defaul device

(Cr :::;:::::[‘:: ﬁ [USB Ausic Conrler |

(@) raswnsoness || B ST
R Microsoft Outlack

MIDI music: playback

3. Select “Edit” and then click “Audio Properties” towards the bottom of the menu to s Delaitdevee

<5 | Microsolt 55 Wavetable SW Synth ]
select “Audio properties” interface. E]

‘% Sound - Sound Recorder

’ : [ Use only defsult devices
', Sound - Sound Recorder File NS Effects Help [ Mute
2 Effects  Help opy Cirl+C [k J[ Cancel J[ emy ] 1USE sudio Contraller

Paste Insert: Chrl+y

Position: Length: . Paste Mix

0.00 sec. (.00 sec.

| Insett File...

Mz with File...

= ; . RUNNING AUDACITY SOFTWARE

|| » | =

Delete Before Current Position

Note: Please review the software license and distribution restrictions found on the
software disc. Use of the Audacity software is subject to those conditions and restriction.

Delete After Current Position

Audio
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For additional help with recording and editing music by using the Audacity software,

please visit http://audacity.sourceforge.net/

1. Run the Audacity from the Windows start menu or double click the Audacity icon on
your computer desktop.

2. The Audacity main screen appears. You will find the Record, Play, Pause, Stop, Skip
to Start and Skip to End control buttons here. Use the File, Edit, View, Transport,
Tracks, Generate, Effect and Analyze menus from your computer screen to Save,
Export or Edit the music.

Be B b Tt Lk e fles

IPPPPP) e

4

Soldien St OFnd Olangn_ susiPoston
haamoo.

* [ponoomonsy | Fonsomassy

3. Click “Preferences” at the bottom of the Edit menu, you can set the Devices, Quality,
and various settings here.

Audacity

Fie W) View Transport Tracks Generste FEffect Analyze Help

T =7 . A e z

= = ) @A R ez
F— 8 ook w0 e nHmmg o] 4 ot wave Devce | SO e wave Devics: £ 3

Clip Boundaries » 20 3.0 4.0 5.0 6.0 7.0 8.0 9.0 10.0 1.0

copy clsc
paste vy
Paste Text to Her Label Chr+ALHY

ouplicate ko
Labeled Regions »
Select »
Find Zeto Crossings 2

Move Cursor »

Region Save
Region Restore.

Flay Region v
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Preferences: Devices
- Devices Interface

~ Playback

~ Recarding
- Quality Using: PartAudio V19-devel (built Feb 4 2012 23:27:31)

Hast: |MIME ~|

- Interface Playback.

- Tracks

- Import | Export

- Extended Impart
Projects
Libraties Device:
Spectrograms
Directaries
Warnings

- Effects

- Keyboard

~ Mouse

Device: |C-Med|a Wave Device

Recording

Channels: ‘2 (Steren)

4. Adjust the input and output volume by sliding the Input and Output Volume bars.

Output Volume Input Volume

o\ /
[ \

@ -

Y
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o "
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‘o
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5. Click the record button to start recording, left and right tracks will show on your
computer screen. If you cannot see the sound waves appear on the Interface when
recording, adjust the Input volume bar.

e ' Pis [ [ml@n] o] o sls2/e[»] o
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6. Use the Audacity control panel to record or listen the music you have recorded
- Click ® button to start recording.

- Click the FM<yytion to skip to start;

- Click the > button to skip to end;

Click the > button to play;

Click the “ button to pause;
Click the n button to stop.

EXPORT THE MUSIC FILES TO WAV OR MP3 FORMAT

Once you have finished recording, make sure you save your recorded music to the

computer.

1. Click File menu and move down to “Export” to convert the file to WAV format or MP3
format.

2. Click on WAV or MP3 format you want to save the music as in pull down menu of
“Save as type” field, and you will be asked for the file name of your recorded music
NOTE: Audacity does not export MP3 files directly. If you want to encode your recorded
music to MP3 format, you need to download the LAME MP3 encoder either in the CD

provided or under the page “Other Audacity Downloads for Windows” of the website
http://audacity.sourceforge.net/

INSTALL THE MP3 ENCODER
1. Insert the included CD into your computer and select “Audacity 2.0(Windows
2000, XP, Vista, 7)” under “Windows” folder.

2. Open the folder and select “Plug-ins”.

3. Double click the “Lame_v3.99.3_for_windows.exe” file under “Plug-ins” folder to

start install the program.

Note: Normally, Audacity will automatically locate the Lame file that you installed.
However, if you change default directory of Lame program, you may need to
manually locate it by using Audacity->Edit->Preference->Libraries and the
click “Locate” button on computer screen to browse “lame_enc.dll” file where
the directory you have installed. See Fig.1 & 2 below and click OK to finish
manual installation.
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Preferences: Libraries @

Devices MP3 Export Library

Playback MP3 Library Yersion: MP3 export library not Found

Recording TMP3 Library:

GQuality

Interface LAME MP3 Library:

Tracks

Import | Expork FFmpeqg Import/Export Library

Extended Import | FRmpeq Library Yersion: FFmpeq library not Found
Libraries mpeq Library: | Locate...
Spectrograms FFmpeg Library:

Directories
\Warnings
Effects
Keyboard
IMouse

Fig. 1

Audacity needs the file lame_enc.dll ko create MP3s,

Location of lame_snc.dll:

arne_enc.dll
To get a free copy of Lame, click here --=

OK ] ’ Cancel ]

Fig.2

CARE AND MAINTENANCE

1. Avoid operating your unit under direct sunlight or in hot, humid or dusty places.

2. Keep your unit away from heating appliances and sources of electrical noise such as
fluorescent lamps or motors.

3. Unplug the unit from the electrical power outlet immediately in case of malfunction.

CLEANING THE UNIT

® To prevent fire or shock hazard, disconnect your unit from the AC power source
when cleaning.

® The finish on the unit may be cleaned with a dust cloth and cared for as other
furniture, Use caution when cleaning and wiping the plastic parts.

® If the cabinet becomes dusty wipe it with a soft dry dust cloth. Do not use any wax or
polish sprays on the cabinet.

® If the front panel becomes dirty or smudged with fingerprints it may be cleaned with a
soft cloth slightly dampened with a mild soap and water solution. Never use abrasive
cloths or polishes as these will damage the finish of your unit.

CAUTION: Never allow any water or other liquids to get inside the unit while cleaning.




TROUBLESHOOTING GUIDE
SHOULD YOU EXPERIENCE DIFFICULTIES IN THE USE OF THIS PLAYER PLEASE REFER TO THE
FOLLOWING CHART OR CALL 1-800-777-5331 FOR CUSTOMER SERVICE.

PROBLEM POSSIBLE CAUSE SOLUTION

AC power cord is not plugged into a .
. Plug the AC power cord into a wall
wall outlet or the connector is not .
. . outlet and plug the connector into the
plugged into the power supply jack

; supply jack on the unit.
The unit does on the back of the unit. PPY]

not respond (no

power). . - Plug another device into the same

Wall outlet is not functioning. outlet to confirm the outlet is working.
o » Slide the POWER ON/OFF switch to
POWER Switch in the OFF position N
the ON position
Unit is ON but .
. The volume Control has been Turn the Volume control to a higher

there is low or
turned all the way down output

no volume

Sound is . .

distorted. Volume level is set too high Decrease the volume

SPECIFICATION

Power requirement:
Main Unit AC 120V ~60Hz 13 Watts

System Requirement: Windows 2000 / XP/ Vista/7

Mac OS X 10.4 - 10.7.5

® At Spectra, environmental and social responsibility is a core
‘ S P E C T RA value of our business. We are dedicated to continuous
implementation of responsible initiatives with an aim to
A\ Y 4 conserve and maintain the environment through responsible
recycling.
Please visit us at http://www.spectraintl.com/green.htm for more information on Spectra’s green
initiatives or to find a recycler in your area.

14

90 DAY LIMITED WARRANTY AND SERVICE
VALID IN THE U.S.A ONLY
SPECTRA MERCHANDISING INTERNATIONAL, INC. warrants this unit to be free from defective
materials or factory workmanship for a period of 90 days from the date of original customer purchase and
provided the product is utilized within the U.S.A. This warranty is not assignable or transferable. Our
obligation under this warranty is the repair or replacement of the defective unit or any part thereof, except

batteries, when it is returned to the SPECTRA Service Department, accompanied by proof of the date of
original consumer purchase, such as a duplicate copy of a sales receipt.

You must pay all shipping charges required to ship the product to SPECTRA for warranty service. If the
product is repaired or replaced under warranty, the return charges will be at SPECTRA's expense. There
are no other express warranties other than those stated herein.

This warranty is valid only in accordance with the conditions set forth below:

1. The warranty applies to the SPECTRA product only while:

a. Itremains in the possession of the original purchaser and proof of purchase is demonstrated.

b. It has not been subjected to accident, misuse, abuse, improper service, usage outside the
descriptions and warnings covered within the user manual or non-SPECTRA approved
maodifications.

c. Claims are made within the warranty period.

2. This warranty does not cover damage or equipment failure caused by electrical wiring not in compliance
with electrical codes or SPECTRA user manual specifications, or failure to provide reasonable care and
necessary maintenance as outlined in the user manual.

3. Warranty of all SPECTRA products applies to residential use only and is void when products are used in
a nonresidential environment or installed outside the United States.

This warranty gives you specific legal rights, and you may also have other rights which vary from state to
state. TO OBTAIN SERVICE please remove all batteries (if any) and pack the unit carefully and send it
freight prepaid to SPECTRA at the address shown below. IF THE UNIT IS RETURNED WITHIN THE
WARRANTY PERIOD shown above, please include a proof of purchase (dated cash register receipt) so
that we may establish your eligibility for warranty service and repair of the unit without cost. Also include a
note with a description explaining how the unit is defective. A customer service representative may need to
contact you regarding the status of your repair, so please include your name, address, phone number and
email address to expedite the process.

IF THE UNIT IS OUTSIDE THE WARRANTY PERIOD, please include a check for $30.00 to cover the cost
of repair, handling and return postage. All out of warranty returns must be sent prepaid.

It is recommended that you contact SPECTRA first at 1-800-777-5331 or by email at
custserv@spectraintl.com for updated information on the unit requiring service. In some cases the model
you have may be discontinued, and SPECTRA reserves the right to offer alternative options for repair or
replacement.

SPECTRA MERCHANDISING INTERNATIONAL, INC.

4230 North Normandy Avenue,

Chicago, I1L60634, USA.

1-800-777-5331

To register your product, visit the link on the website below to enter your information.
http://www.spectraintl.com/wform.htm

0213 Printed in China
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